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Making a Map in ArcGIS using data from PDS Studio Case Recordation 
 
Create Export Files. 

• Go to http://www.pdsstudio.com with your Internet browser. 
• Login. 

 

 
• Select BLM Case Recordation. 

 

 
• Select Wyoming Case Recordation. 
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• Under Available Criteria select Location and enter your desired township and 
ranges.  Use the <tab> key to move between entry fields. 

 
• Click Apply. 
• Under Available Criteria, select Disposition and move Authorized and Pending to 

the right by clicking the single right arrow.  Use the <CTRL> key to select 
multiple selections from the list.  Use the <SHIFT> key to select multiple 
continuous selections from list.   

 

 
• Click Apply. 
• Under Outputs, Reports select Case Type Frequency. 
• Put in a Title if desired. 

 

 
• Click Continue. 
• Under Completed Outputs, Description, click on the bold underlined report title to 

view report in Acrobat Reader. 
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Determine what layers to map. 

 
 

• Click the back button on the main toolbar to return to Completed Outputs. 
• Click on BLM Case Recordation Home to return to Case Recordation Criteria 

selection options. 
• Under Application Queries use the drop down menu to select Active Oil and Gas 

Leases.  Click the Recall button. 
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• Click on Location under Available Criteria.  Enter your desired township and 

range.  Click Apply. 
• Under Outputs, Exports, click on Ownership CarteView Export. 
• Under Export Options take the defaults and click continue. 

 

 
• Enter a report title under Description if desired and click continue. 

 

 
• Under Completed Outputs, Description, click on the bold, underlined report title 

to activate WinZip.  (You may also right click on the report title and choose Save 
Target As to save the zip file to the folder of your choice.) 
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• At the File Download dialog box you can open, save or cancel the operation.  
Select open. 

 

 
 

• Close the Comment dialog box. 
• Highlight the zip file and either click on the extract icon in the toolbar or right 

mouse click and choose extract. 

 
 

• Navigate to the desired folder and click the Extract button. 
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• Repeat the procedure for other layers such as units, communitization agreements, 
participating areas, closed leases, etc. 

 
 
Process Export Files and Create Map Layout. 
 
 

• Open ArcMap. 
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• Add section and township data layers.  Click on ‘Add Data’ icon  and browse 
to file location. 

 

 
 

• Change display of layer by either right clicking on the layer name, choosing 
properties and then choosing the symbology tab and clicking of the symbol box or 
by simply clicking on the symbol directly below the layer name.  The symbol 
selector dialog box will come up.  Choose the fill color, outline width and outline 
color.  For more detailed fill options select Properties and select Type for other 
fill options. 
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• Label the township layer so you can clip the grid to the desired map area by right 
clicking on the township layer and selecting Properties.  Click of the Label tab.  
Put a check mark in the Label Features in this layer box.  Under Text String use 
the drop down menu to select the desired label field or select expression to label 
multiple fields.  Click on the Symbol button to select font size, color and Label 
Placement Options button for label placement and other options. 
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• There are two methods to displaying only the desired area for your map.  You can 
permanently clip the grid or you may clip the grid only for display purposes.  We 
will review both.  Please note that if you are clipping the grid the grid must be 
read/write.  It is always a good practice to work with a copy of the grid in the 
event that an error occurs during editing. 

 
Method One; Clipping the grid for display only. 

• Choose Selection, Set Selectable Layers and check only the township layer. 
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• Use the Select Features icon  to draw a box that includes only the townships 
of interest.  They will be highlighted. 

 

 
Right click on the Layers data frame and choose Properties, click on the Data Frame tab.  
In the Clip to Shape section of the dialog box, check Enable.  Press the Specify Shape 
button and click on the outline of features toggle.  Choose the township layer and only 
the Selected features of this layer.  Click OK twice. 
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Method Two; Permanently clipping the grid.  

• Highlight the township layer.  Use the feature select tool  to draw a box to 
select the desired townships.   

 
 

• Right click on the township layer and select data, then export data.  Save the file 
to the desired directory and call the layer township.  Add the data to the existing 
map. 

 
• Repeat the process for the section layer.  Save the file as sections. 

 
• Remove the original data layers from the map by right clicking on the layer and 

selecting remove. 
 

• You will need to change the display properties of both the new township and 
section grid layers as was done previously.  Labels will also need to be added. 
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• You may need to do some further editing of the section layer, especially if the 

townships are offset.  To edit individual sections make sure your editor toolbar is 
visible.  If not, right click on the main toolbar and the various toolbar options will 
be available.  Highlight the editor toolbar.  On the editor toolbar click on the 
editor and select start editing.  Make sure you have selected Cut Polygon Features 
in Task and have selected sections in Target.  With the editor arrow  draw a 
box around the sections you wish to remove and hit the your delete key.  Repeat 
the process until you’ve removed all the desired sections.  Click on editor and 
select Save Edits.  Click on Stop Editing. 

 

 
 
 
 
We are now ready to process Premier *.exp files create via PDS Studio or other sources.  

Click on the CarteView icon  on the toolbar.  The CarteView dialog box will appear.  
If the CarteView icon is not visible refer to Appendix B for instructions. 
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• If the Output in grid projection and Output in dataframe projection is grayed out 
the section grid does not have an associated *.prj file with its projection 
information.  In this case, the output of the processed data will have the same 
projection of the section grid you have open.  If you wish to define a coordinate 
system for a layer refer to appendix A for instructions. 

 
• If your section grid has an accompanying prj file with the projection information 

and data frame projection information is set CarteView for ArcGis will look like: 
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You may select to output the data in the grid projection or in the dataframe projection.  
To change the projection of the dataframe please refer to Appendix A. 
 
Click on the ellipses button (…) under PDS Export File/CSV File to navigate to and 
select the desired PDS Studio export file to process.  Click on the ellipses button under 
Output Theme and navigate to the file folder you wish to put your output shape file.  
Type in the name of the output shape file. 
 

 
 

• Enable Merge Regions.  Enable Meridian if necessary.  Enabling meridians is 
necessary only when processing data in a map area with multiple meridians that 
contain identical townships.  Select output projection.  Click on Run.  Repeat the 
process for all the export files you created in PDS Studio to produce the 
individual layers in ArcGIS. 
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• Reorder the layers and change the symbology of the layers to create the desired 
map.  To reorder the layers, simply highlight the layer you wish to move.  Click 
and hold on the layer and drag it up or down as desired. 

 
• Move the units layer to the top.  Click on the symbol under units to initiate the 

Symbol Selector Dialog box.  Click on Hollow for fill.  Click on Properties.  Click 
on Outline.  Scroll down to Dashed with 2 Dots and select.  Change the width to 
2.0.  Click on OK three times to return to the Data View screen. 
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• Move the township layer directly below the units layer.   
 

• Move the section layer directly below the township layer.   
 

• Move the active layer directly below the section layer.  Right click on the active 
layer and select Properties.  Select the Symbology tab.  Under Show on the left, 
click on Categories.  Click on Unique values.  Under Value Field use the drop 
menu to select Name1.  Select the desired color scheme using the drop down 
menu.  Click on Add All Values. 
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• Move closed to the bottom of the list.  Click on the symbol under the Closed layer 
in the legend to initiate the Symbol Selector Dialog box.  Select Rose for the fill 
color.  Select No Color for the outline color.  Click OK to return to the Data View 
screen. 
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• Click of the add data icon  and add the active shape file layer again.  
 
OR 
 

• You may copy and paste the active layer back into the data frame.  Right click on 
the active layer and choose copy.  Then right click on the layers data frame and 
choose Paste Layer. 
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• Right click on the top active layer.  Select Properties. Select Symbology.  Under 
Show, on the left, select Categories.  Select Unique values.  Under Value Field 
select HBP.  Click on Add All Values.  Double click on the Symbol that doesn’t 
have a value, these are the leases that are not HBP.  In the Symbol Selector click 
on Hollow.  For the Outline Color select No Outline Color.  Click OK.  Unclick 
<all other values> so the non-HBP leases are not shown.  Click on the symbol 
next to HBP.  Scroll down to and select 10% Ordered Stipple.  Click No Outline 
Color.  Click on Properties.  In the Symbol Property Editor select Background 
Color on Picture Fill tab and click on No Color.   
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• Click OK three times to get back to the Data View screen. 
 

• Highlight the units layers and right click and select Properties.  Select the Labels 
tab.  Put a check mark in the Label Features in this layer box.  Leave Method as 
Label all the features the same way.  Use the drop down menu under Text String 
and Label Field with GeoName.  Click on Symbol under Text Symbol and select 
desired font, size and color.  Click on Properties for additional font options.  Click 
OK to return to the main screen.   
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• At the Label tab click on Label Place Options under Other Options.  Under the 
Conflict Detection tab, using the drop down menu choose Label Weight as High.  
Under Feature Weight , using the drop down menu choose Feature Weight as 
High.  Place a check mark in the Place Overlapping labels box.  Click OK twice 
to return to the data view screen. 
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• Highlight the lower active layer and right click and select Properties.  Select the 
Labels tab.  Click on Expression.  Delete any label currently in the white 
Expression box.  Under Label Fields highlight SerialNumb and click Add.  Repeat 
the process with Name1, ExpireDate, Price, and OR.  This will place all the labels 
on the same line.  To insert carriage returns and spaces between the labels type in 
the following: 

 
• [SerialNumb]  & vbcrlf & [Name1]  & vbcrlf & [ExpireDate] &"   "  & " $" & 

[Price]  & "  " & [OR] 
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• This will put a carriage return after the serial number and after Name1, which is 
the majority record title owner.  It will also put spaces between Expiredate and 
Price and OR, which indicates if operating rights have been severed.    A dollar 
sign will also be added in front of the numerical dollar amount bonus bid for a 
particular lease.  Click OK.  Click on Label Placement Options under Other 
Options.  Select High for both Label Weight and Feature Weight.  Put a check 
mark in the Place overlapping labels box.  Click OK.  Verify that you have a 
check mark in the Label Features in this layer box.  Click OK. 

 
• At the top of ArcMap, select View, select Layout View.  Under File select Page 

Setup.  Select desired printer/plotter under Printer Setup Name.  Select Portrait or 
Landscape.  Select Printer Page Size if you want a preformatted default paper 
size.  If you want a custom print size, type in the desired width and height under 
Map Size.   
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Drag corners of outlined map to position and size the map on your desired page size. 
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• You may also right click on the virtual layout map, select properties and select the 
Size and Position tab and type in your desired map size and position.  Be sure to 
allow for print margins.  For standard paper sizes you may right click outside the 
map area, select page setup and place a checkmark next to display printer margins 
on layout. 
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• Right click on your map, select Properties, select Frame.  Choose your desired 
Border type and color, as well as, other desired properties and click OK. 
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• Click on Insert Menu at the top of the screen and select Legend. 
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• Remove map layers you do not want to display in your legend by highlighting 
them and moving them to the left under Map Layers using the left pointing arrow.  
Move map layers that you want to display in your legend to the right window 
under Legend Items.  Move layers in your Legend up or down using the arrows.  
Click on Next.  Add Legend title, change font size and color, choose justification, 
etc as desired.   
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• Click on Next to change Legend Frame.  Click on next to change legend patch 
size and shape.  Click on next to change legend format.  Click on Finish. 

 
• Click on the map.  The anchor points of the map will appear.  Right click on the 

map, select order, select send to back.  Right click on the legend, the anchor 
points of the legend should appear.  Click and hold on the legend and drag the 
legend to its desired location. 
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• At the bottom of layout view select font type, size and color of additional text you 
wish to add. 

 

 
 

• Click on the A on the tool bar.  Move to the location you want to type in 
additional text.  Right click and type in the desired text.  Click on the box to move 
the text to another location.  Right click on the text box and select properties to 
change text, font size, color and other attributes. 
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• Under File select Print.  Click on Setup to verify plotter and paper size and 
orientation.  You will need to also click on Properties under Printer Engine, 
Windows Printer to verify paper size and orientation for custom paper sizes. 
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Appendix A 
CarteView for ArcGIS 

And Coordinate Systems 
 
CarteView provides the ability to produce the output shape file in either the coordinate system of 
the input land grid or the coordinate system of the ArcMap data frame when the coordinate 
system of the input land grid is known.  For example, you can create an output shape file in a 
specified UTM zone, NAD83 when your land grid is stored in geographic, NAD 27.   
 
To take advantage of the reprojection capabilities of both ArcMap and CarteView, it is 
recommended to have valid coordinate system information for your land grid files.  The land grid 
coordinate system definition requirements outlined here are ESRI standards.  A shapefile's 
coordinate system parameters are stored in the same location as the shapefile, in a .prj file with 
the same name as the shapefile. For example section.prj would be the projection file for the 
section.shp file.  A coverage’s coordinate system parameters are stored in the same location as 
the other coverage files. The gcdb\prj.adf file would be the projection file for the gcdb coverages.   
Instructions on how to create these files if they do not exist are detailed below in How to Define A 
Coordinate System For A Layer.   
 
 
When Coordinate System Information Is Available 
 
CarteView supports output in either the input land grid coordinate system or that of the data 
frame.  By default, the output will be in the coordinate system of the input land grid.  When you 
want the output shape file in a different coordinate system, you can change the ArcMap data 
frame projection and choose to have your output in that projection.  For example, if your input grid 
is in Geographic (lat/long) NAD 27, CarteView can generate your output in State Plane, UTM, or 
any of the other ESRI-supported projections with a NAD27, NAD83 or other supported datum.  If 
you just want to view your data in these projections, CarteView can keep your output in 
Geographics, and ArcMap will reproject it only for display.   
 
The CarteView dialog box has a toggle for selecting the land grid or data frame projection. 
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To view the spatial reference property of a layer, right click on it in the legend to bring up the 
Layer Properties dialog box.   
 

 
 
Choose the Source tab. 
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To set the coordinate system of the data frame to something other than the first layer added to 
that data frame, follow the steps below from ESRI’s ArcGIS Desktop Help: 

1. Right-click the data frame that you want to set the coordinate system of and click 
Properties.  

2. Click the Coordinate System tab.  
3. Double-click Predefined.  
4. Navigate through the folders until you find the coordinate system you want and click 

it.  
5. Click OK. All layers in the data frame will now be displayed with that coordinate 

system.  
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Your map will have changed coordinate systems and depending on the extent and projection 
chosen, its appearance. 
 

 
 
You can now choose either the land grid projection or the data frame projection for your 
CarteView output. 
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When No Coordinate System Information Is Available 
 
When a land grid shapefile or coverage does not have any information defining its coordinate 
system, CarteView follows the ArcMap model for determining the possible projection of the map. 
There are two basic behaviors.  If the map’s extent is within the range of -180 and 180 in the x 
direction and -90 and 90 in the y direction, ArcMap and CarteView assume the data to be 
geographic and its datum to be NAD27.  In this case, the land grid’s Spatial Reference property 
will be GCS_Assumed_Geographic_1.  To view the spatial reference property of a layer, right 
click on it in the legend to bring up Layer Properties dialog box.  Choose the Source tab. 
 

 
 
 
CarteView will be able to generate the output shape file in either this assumed coordinate system 
or in the coordinate system of the data frame.  
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Note however, that when the spatial reference property of a layer is 
GCS_Assumed_Geographic_1, ArcMap does not automatically perform datum shifts. Therefore, 
any datum shift used on the data frame coordinate system will not be calculated correctly in the 
output shapefile unless you define a datum transformation for ArcMap to use.  For example, if the 
land grid is really in Geographic NAD 27, you must tell it to use the NADCON translation method 
to go from GCS_Assumed_Geographic_1 to any coordinate system that uses NAD 83.  In the 
following example, you are changing the data frame to Geographic with a NAD 83 datum.  After 
selecting the new coordinate system, press the Transformations… button. 
 

 
 
There are no predefined transformations from which to choose.  Select New… 
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Choose the NADCON method, give your transformation a name, and press OK. 
 

 
 
Press OK in the Geographic Coordinate System Transformations dialog box and OK on the Data 
Frame Properties dialog box to accept the new transformation.  Your datum shift will now work 
properly between NAD 27 and NAD83.  See the ArcGIS Desktop Help section on Geographic 
transformation methods for more information. 
 
When the land grid shapefile or coverage does not have any projection information and its extent 
is outside the range of -180 to 180 in the x direction and -90 to 90 in the y direction, CarteView 
and ArcMap do not make any attempt to determine the projection.  When you add the land grid to 
the data frame ArcMap displays the following warning message: 
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The land grid’s Spatial Reference property will be “Undefined”.   
 

 
 
The CarteView check boxes for choosing a projection are ghosted, you are not allowed to choose 
a projection.  You are shown a message stating that the land grid projection is unknown and no 
reprojection is possible.   
 

 
 
The CarteView output file will actually be in the projection of the input grid, even though it is 
unknown to ArcMap and CarteView.  Note that you can change the coordinate system of the data 
frame, but it will have no effect on either the ArcMap display or the CarteView results.   
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How to Define a Coordinate System for a Layer 

You can define shapefile and coverage coordinate systems in ArcCatalog or ArcToolBox. You 
can select one of the predefined coordinate systems provided by ESRI, import the coordinate 
system parameters used by another map, or define a new coordinate system.   You must know 
what the coordinate system of the land grid actually is before you define it.  Setting the definition 
file will not actually make the data stored in that coordinate system; it only informs ArcMap and 
CarteView of the projection so they may perform accordingly.  As a very general rule for many 
land grids in the US: 

• If the Y coordinates are within 0-90, the projection is Geographics. 
• If the Y coordinates are in the hundreds of thousands, the projection is State Plane. 
• If the Y coordinates are in the millions, the projection is UTM. 

There are three maps at the end of this document that show where the UTM and State Plane 
boundaries are for the Western United States.  If your data extends farther than a single zone, it 
is most likely in the zone that covers the majority of the area.  Note that there is no general rule 
for determining the datum of the data.  At present, most data is in either NAD 27 or NAD 83.  

A shapefile's coordinate system parameters are stored in the same location as the shapefile, in a 
.prj file with the same name as the shapefile.   

To activate ArcCatalog from ArcMap, simply press the ArcCatalog button on the toolbar.  The 
following instructions are from ESRI’s ArcGIS Desktop Help for ArcCatalog, under the title 
Defining a shapefile's coordinate system: 

1. Click the shapefile whose coordinate system you want to define.  
2. Click the File menu and click Properties.  
3. Click the Fields tab.  
4. Click the Shape column in the column list.  
5. In the Properties list below, click the ellipses button (...) next to the Spatial Reference 

property.  
6. In the Spatial Reference Properties dialog box, click Select and then choose a predefined 

coordinate system.  

Or, click Import and then choose the data source whose coordinate system parameters you 
want to copy. Or, click New, click Geographic or Projected, and then define a new, custom 
coordinate system. 

7. Click OK in the Spatial Reference Properties dialog box.  

In the Shapefile Properties dialog box, the name of the coordinate system appears next to the 
Spatial Reference property in the Field Properties list. 

8. Click OK in the Shapefile Properties dialog box 
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A coverage’s coordinate system parameters are stored in the same location as the other 
coverage files (e.g. the gcdb directory), in a file named prj.adf.  You must have an ArcInfo or 
ArcEdit license to generate the prj.adf file for a coverage; an ArcView license will not provide this 
capability.  

To activate ArcCatalog from ArcMap, simply press the ArcCatalog button on the toolbar.  The 
following instructions are from ESRI’s ArcGIS Desktop Help for ArcCatalog, under the title 
Defining a coverage's coordinate system: 

1. Click the coverage whose coordinate system you want to define.  
2. Click the File menu and click Properties.  
3. Click the Projection tab.  
4. Click Define.  
5. Click Next.  
6. Click the appropriate coordinate system in the Projections list on the left.  

A description of the coordinate system appears on the right. 

7. Click Next.  
8. Enter the appropriate parameter values for the coordinate system; each one has a different 

set of parameters.  
9. Click Next.  
10. If the coverage uses a projected coordinate system, click the datum it uses, or click 

Spheroid and define the spheroid's parameters.  
11. Click Next.  
12. Review the summary of the coordinate system that will be assigned to the coverage. If 

you want to change something, you can go back through the wizard by clicking the Back 
button. Click Finish if you want to use this coordinate system.  

The coordinate system and its parameters now appear in the Coverage Properties dialog box. 

13. Click OK.  
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Available On-Line Help 

The following is a list of ArcGIS Desktop Help topics that may be of interest.  To get help for 
ArcMap, select Help from the menu bar, and then choose ArcGIS Desktop Help.  Use the Search 
tab to find these titles.  If you check Search titles only in the bottom left corner of the ArcGIS 
Desktop Help screen, you will find the exact topic entered.  If you check Match similar words, you 
will find similar articles that may also help you learn more about map projections, datums, and 
coordinate systems. 
 
Specifying a coordinate system 
Defining a shapefile’s coordinate system 
Defining a coverage’s coordinate system 
 
Universal Transverse Mercator 
State Plane Coordinate System 
Geographic Coordinate System 
Datums 
North American datums 
U.S. state plane zones (NAD 1983) 
U.S. state plane zones (NAD 1927) 
Geographic transformation methods 
 
About coordinate systems 
About map projections 
About projected coordinate systems 
About geographic coordinate systems 
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Appendix B. 
Adding the CartéView Command to ArcMap 

 
After you finished installing ArcGIS and CartéView for ArcGIS, you must manually add the 
CartéView command to the ArcMap toolbar. 
 
 

• Start ArcMap. 
 

• Click the Tools menu and click the Customize option. 
 

• Select the Commands tab and click the Add from file... button. 
 

• Navigate to the "\arcgis\arcexe81\Bin" folder and select the "CVArcMap.dll" file and click 
the Open button. 

 
• The "Added Objects" dialog should display listing CarteViewForArcMap in the dialog.  

Click OK. 
 

• The Commands tab in the "Customize" dialog should now have Premier Data Services 
listed under the Categories list and CarteView listed as the corresponding command 
under the Commands list. 

 
• Click and drag the CarteView command from the Commands list and drop it on the 

toolbar. 
 

• Click the Close button. 
 
You will now see the CartéView button on the toolbar every time you open ArcMap. 
 
 


